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Core Project(#71 H) .Embedded Project (#ix AT H) . Integrated Library (£ st/ 230
H) A1 Script Project (3R H) 6 Fh2sHl,

T BB AR — RS — I E SO S R N Pryx o« 7 Hip,
“oowox VIR FTRTEI H R AL E 1Y . O R S H TR S A SO Z T OC AR
FEARRE AL E TN ZEENH] AR i A b, gy S g sr — A PCB 0 H S0, f
1 PCB I H SCHX AR R AT » 7] — 300 H oA [ SO AT LA b PR A7 7E 8] — S0 e v, 4
AR SR P SV PCB SO AE LA S S B ARAAAETH L . FE A SCAFI, 7T LA
T PCB 35 3 SRy 5 20 315 50 B A OG0 BT A SO ] DRIt B eb i S SO LA
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F1-1 BRAMNMHEE
Ji PP S * . SchDoc T H 4 o .OUTJOB
PCB St * . PcbDoc CAM 3 ftk .CAM
JE3R P T S A % . SchLib FHL S0 AR S A . DML
PCB JeA 25 o A . PcbLib L 17 L 19 2% 2 S . nsx
VHDL TestBench {4 x. VHDTST FL 7 L H A S . ckt
VHDL JE 3 * . VHDLIB EDIF 34 . EDIF
VHDL 803 74 * . VHDMDL EDIF 30 . EDIFLIB
CUPL PLD 3 {4 *. PLD Protel (¥ 4% 3 3014 .NET
CIBFH 3 x.C SCA S . txt
CH+HB = E *. CPP TEPF 55 8 B AR A R SO . lib
Delphi i& 5 2301 % . pas BY x . bas 15 B BT S Lsdf
Kl PRBE R SO » . DBLink

A Altium Designer 16 16 SCRFVF 2 B0 85 =7 80 0 SCOA% 20 15038 T LR ISR 5
File T Import Wizard fig 21 TANTE ARSI . X T RGBT R 7™ A i) — SE 4

SO D] LA 388 T R R BT T

= .Altium Designer 16 I RS SHIZ S

Ja 31 Altium Designer 16 Ji5 . 75 13 B $47“DXP”— " Preferences

TN

Preferences

Al < o

| [ cloud Preferences

| b I System
» E3 Data Management
& B3 Schematic
v 3 FPGA
v [ PCB Editor
1 3 Text Editars
1 3 Scripting System
b [ CAM Editor
b I Simulation
» B3 wave
b [0 Draftsman

@ System

Cloud Preferences

DXP Settings can be saved to the dloud for access any where, any time, You must sign in to use this feature. Use the link
inthe cloud preferences banner above to sign in.

[Set]'nDthulL\ |v] [ Save... H [ Load.. |.] [ Import From... \vl

oK concel | |

1-19  Altium Designer 16 555158

FI A 1-19
iR R Preferences” X 4G HE , XFEHE Fh 2200 16 43 4 571 & R A 0 £18) 258 300 = 79 38 2o 4t 22
A 5 2% 5 7 T A P S8 00 R A A, A {00 ) 38 0 S8 s 2 00 4 A 76 1) 2 r e () S T 1
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Altium Designer 16 42 K85 1 S50 B3 5 B — 1" Preferences” XEHE 1, M40 7%
System( R4t B ) .Data Management ({4545 ¥) . Schematic (JE I K 4i 45 ) . FPGA (FPGA
%11 JPCB Editor (EIRIHEL B4R 2845 . Text Editors(SUANGRE#S) | Scripting System (A
A5 E) . CAM Editor (CAM 48 #%) | Simulation (5 2L 4 5 #%) . Wave (S ¥ 4 5%) |
Draftsman (2218 B B 11 A-H30041, 48 BIEF X REER 10 A TIREBH I B A5 (L4028
System (R GLBE) VU A AHIC A 25 » HAB LI 2H 04 15 & AEAH DGR AR 43 A T I

1t System ZEIZH A 16 SEI-R L 43502 General Gl FIIETT-R) | View (1L 1#] 7 3
). Account Management (i J & B 10 ) | Transparency (i W] & 2 35 ) | Navigation
CFRALEETT R ) Design Insight G THRZEEDT R ) Projects Panel (31 H Hi#ii i 5 ) | Default
Locations CERIAf B %63 ) L File Types(SCA4EZERIET ) . New Document Defaults GFF 3
R4 ) L Desktop Layouts (i T 4 J5) 6 3 ) | Printer Settings (3] EJHL % & ¥ 30 R |
Installation (&3 EI )  Altium Vault(Altium B RAEEIE LT ) . Product Improvement
(7 G T ) L Network Activity (2% 1 22635 1) . 3¢ B E 15 - P 19 = ZE 36 1 T fig 43
AT

1. “General” £ I F

“General "PEI-RANIE] 1-20 Fios igb -1 8 REEH T AL REEI. AR SCINT .

‘ Cloud Preferences " |
I

4 [ System |
u ‘%| @ System — General !
5 View
' & Account Management Startup
i
e e —

i Design Insignt [¥] Open Home Page if no documents open

&3 Projects Panel
i3] Default Locations

[7 show startup saeen

General
i€ File Types
% New Document Defautts [¥] Manitor clipboard cantent within this application anly
i3] Desktop Layouts T _—— .
&) Printer Settings - ifsikie ot At Designes

(7 Never

i Installation .
) Altium Vault @ Ask User

&l Product Improvement [¥] Only ¥ Document s Modified

3 Network Activity ) Always
Data M t
» B3 Data Management -
¢ B3 Schematic
Use localized

[ =R
v I PCB Editor
1> £ Text Editars

[7] Localized menu: |
Display localized hints only |
3 Seripting System
1 [ CAM Editor

& [ Simulation

» B3 Wave

1 [ Draftsman

[s:unn:_mlu |-] [ Save.. |-] [ Load... |-] [ Import From... H oK | [ Cancel ] \ Apply

1-20 “General”’ &I



(1)*“Startup” #eI5 X f5l . % R G0 J7 Zhad B b AT 3 Horp & 3 N RAE.,

(D“Reopen Last Workspace” & %AE : I T & 148 3 Altium Designer 16 B}, 275 H 3l
IO E—UGR I R GERTHY TAEZS 0], 275 A S SCH A Ay H 4. % T LAARIH ARZESAT
JF#) Free Documents, WANZs H 3Nk .

@“Open Home Page if no documents open” & 1% AE : F T1% & 78 3 Altium Designer
16 J& » AR BA SCRATIT . RGEE ASITIFRGE L.

©“Show startup screen” & VEHE : ] T3 &AL shid B b 25 Wos R A sh FLm .

(2)“General” I X 35 . B A —>“Monitor clipboard content within this application
only” ZHHE, HTHCE BYIEAUZ R AUE/R Altium Designer 16 HEJINZ

(3)“Reload Documents Modified Outside of Altium Designer” &30 X ##% . ] TiX & 275
HH Nk Altium Designer Z /MNUEECCRY . A LI 3 AL,

(DNever: MAEH F 2k Altium Designer Z AMUIEHCRY .

@Ask User: fIFl A& W, #EH“Only If Document Is Modified” & $EHE . F R ANAE ST
RYBAE ROSOR I AR 3R] P UL s 75 00 AR

@ Always: 1t RN IHA T H T 2 Altium Designer Z ZMERCCHY .

(4)“Localization” B I X $5§ : F] T B & kP REH R .

1 “Use localized resources” s EHESS i IX I8y 3 A~ B L+ SR BT - o ir AT
ik & .

@ “Display localized dialogs” B4 : H T8 B AT EAE S 75 (i I BEE s

@“Localized menus” Bk F 4 . H T3 B U SRR TR,

@“Display localized hints only” %4 : T3 & 2B B AR o

2. “View” £ I F

“View”EIRANE 1-21 Jros ., 1 3CE 2R 4800 K I8 7 09 2 004 0, B0 18 25T 2
wr.

(1) “Desktop” ZEI X 35§ : F T B R 505 T 1) /R 50 .

D Autosave desktop” I YEHE : HI T B & RGE M, S A Sh IR R G T R (5 B

@*“Restore open documents” 2 PEHE : ] T B8 2 AR FTIFHY SR .

Exclusions : HEBR A P2 AT LLIE 2 0] 5 0 15 HE L 45

(2)“Popup Panels” 50 X3 F T8 B TAE TR & 1 0958 R I A .

D“Popup delay”#5 H5 S T AR AR BT 55 0 GE 58 I (] o R [R] 8 T4 6 11 560 1

o>
[ayay
>
e

@*Hide delay” i BBz B TR T M 5 11 9 BROBCIE IS IS 18] o A7) e o T Al 7 1 G o J3E

@*“Use animation” & YEHE . F 15 B 1 Al i S sl Beulasd F v i sl R s . s e Al itk
BRI,
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4 [ System

General
| i view

&3] Account Management
i3 Transpareney
&3 Navigation
&3 Design Insight
i Projects Panel
i3] Default Locations
3 File Types
&3 New Document Defaults
5] Desktop Layouts
i3] Printer Settings
g3 Installation
&3 Altium Vault
&3 Product Improvement
I3 Network Activity

» [ Data Management

@ System — View

Desktop

[¥] Autosave desktop
[¥] Restore open documents

Exclusions:

Show Navigation Bar As
(@ Built-in panel
@ Toolbar
[Z] Always Show Navigation Panel In Tasks View
General

[¥] show full path in title bar

Popup Panels
Popup delay: ]
Hide delay: I

[¥] Use animation
Animation speed: ]
Favorites Panel

[¥] Keep 413 Aspect Ratio

T

Thumbnail X Size: 96

ThumbnailY Sizet 72 |5

Documents Bar

[¥] Group documents if need

‘ Cloud Preferences -‘ |

b 3 Schematic

ide floating panels on focus change @ By document kin @) By projes
b I FPGR [ Hide floati 15 on focus cha By d t kind ) By ¢ i
» B3 PCB Editor Remember window for each document kind Use equal-width buttons
B Text Editors [] Auto show symbol and model previews [F] Auto-hide the documents bar
1+ 3 Seripting System [¥] Open internet links in external Web browser Multiline documents bar
v £ CAM Editor Ctrl+Tab switches to the last active document |
v B3 Simulation [¥] Close switches to the last active document !
v I Wave ] Middie click closes document tab il
& 3 Draftsman
Set To Defouits |~ [ Sove.. [-| [ Loads |-| [ importFrom.. || ok | [ucenceli ] [ 4onl

1-21

@ Animation speed” ¥ i & 2l M CHR W (R . I TA]ERAT . 20 I ROR s 1Bk

(3)“Show Navigation Bar As”#E3 X 4k . FH F15 B S0 T HA ) BoR 50 .

@O“Built-in panel” kel . FH TR E AL T HAE R AN EHARE BIR.

@ Toolar” 44l : HI T ¥ & e A5 LA T RAE R

@ “Always Show Navigation Panel In Tasks View” & B HE : H T & B B S A TEAE S
NS L RTINS SN

(4)“Favorites Panel " 335 [X 35§, : FI 15 & WORCIE T AR 0 /R 1510

D“Keep 43 Aspect Ratio” s FEHE : T 15 B OB AU A PR FFK 0 4 <3 19 Hepil o .

@“Thumbnail X Size”: T &AM E X 1R

@“Thumbnail Y Size”: F TIXE 48K Y K/,

(5)“General " e 30 DX I8 : FH T8 — M@ 1 .

D*“Show full path in title bar” 52 HHE . Hl TUCE TEFR R 2 BR SE B B A

@*“Hide floating panels on focus change” & $EHE . F T-15 & 75 17 s T AR _J& 75 B o
Ak

®@“Remember window for each document kind” & iEAE . T I% B B S i0E & SCRY S
RIE H.

“View”i£ I F

s



@ Auto show symbol and model previews” & BEHE . F T1% & 275 H 8 B/ £ 5 Fs Al
R

®“Open Internet links in external Web browser” & $EHE . F 15 B & 5 1E 7S X 253
Yo as h AT R R

(6)“Documents Bar” 501 X 3k . FH T8 B SCHER2 8 2

D*“Group documents if need”Z ¥EHE . FH T B 4G XA

a. “By document kind” BLIFZ4H - # S0 FPZE

b. “By project” IHZ 4  4Z I H .

@"Use equal-width buttons” & #EHE . FI T & 75l & o4l

@“Auto-hide the documents bar” & %AHE . T B &1 H shFRk SCRYF:

@®*“Multiline documents bar” & IEHE . Fl Ti% B BB N E S CMHFL,

®“Ctrl4Tab switches to the last active document” & %HE . F T B 2 & % H“Ctrl+
Tab” Y3 b —ANE 3 3CR .

®“Close switches to the last active document” & i%HE . FH T B &4 LAY 38 K5
— NGB SR

@*“Middle click closes document tab” % EHE . A F 1% B & 5 75 o 18] BA 5 56 ] SCRY
TR

3. “Account Management” £ 15+

FHFU B3 1k ]2 S FH P K P 24 Fn s i s 2.

4 “Transparency” %I &

“Transparency” VeI -RANE] 1-22 PR, 1B R N Y EI0 32 250 8 77 ) T HA RO
HE BB BRI . Hoh s i i LR Lk

(1)“Transparent floating windows” & &HE . Fl T E R H— 1 B S B miaes T
VEIX B 77 3l T A= K HA RS HERT , 275 DB I RCR s .

(2)“Dynamic transparency” g ¥BHE . F T8 Hah 58 RUR .

(D*Highest transparency” 1 . FF15% 22 5 a5 B EEE, B A (EROR .

@"“Lowest transparency” It . F T5 & Fe Ml B B (R, i POl e A (BB,

@*Distance factor”# 8t : FI e YEAn iR 85 1% 2 T HA% V7 2 6HEAE 5l I 3 T A 25
R 2Dt EBIHORIE R . PSR R
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20

‘ Cloud Preferences

4 [ System
K3 General
K3 View
i Account Management
i3 Transparency
i3 Navigation
i Design Insight
) Projects Panel
i3] Default Locations
I3 Fite Types
&3 New Dacument Defaults
i) Desktop Layouts
) Printer Settings
53] Installation
&3 Altium Vault
i Product Improvement
i) Network Activity
» I Data Management
1+ £ Schematic
v [ FPGA
» £ PCB Editor
¢ 3 Text Editors
1+ 3 Scripting System
b [ CAM Editor
b I Simulation
» B Wave
i+ E Draftsman

ﬁ System — Transparency

Transparency
[#ffransparent fioating windows:
Use this option to automatically make all floating toolbars and windows over the editor area transparent when an
interactive process is invoked,
[¥] Dynamic transparency

With this option set the transparency of floating windows is determined dynamically. The system uses the distance of
each window from the cursor to calculate its transparency.

Highest transparency: |

U

Distance factor: | 5]

Lowest transparency:

SetTo Defaults || [ save.

] [ toads -] [ import From.. -] [oee ] [Lcancet ] [ 400y

B 1-22  “Transparency” % Ii

5. “Navigation” & Il

“Navigation” 35K A& 1-23 frs » T2 TR S AR . H PR mii 4 an v

‘ Cloud Preferences

a [ System
53] General
) View
&3] Account Management
1 Transparency
g3 Navigation
&3 Design Insight
i) Projects Panel
i3] Default Locations
i3] File Types
K3 New Document Defautts
] Desktop Layouts
i) Printer Settings
i3 Installation
&3 Altium Vault
&3 Product Improvement
1] Network Activity
» 3 Data Management
1+ £ Schematic
b 3 FPGA
©» 3 PCB Editor
i 3 Text Editors
1+ [ Seripting System
b 3 CAM Editor
b 3 Simulation
» £ Wave
1 [ Draftsman

ﬁ System — Navigation

Highlight Methods

Choose here the methods used to highlight graphical objects during navigation, These options are used during
navigation, and when exploring differences between documents or compiler messages.

[ZIZooming! Selecting
[¥] Masking Connective Graph
[Cinclude Power Parts
Zoom Precision

The zoom precision option controls how closely the system will zoom into to highlighted objects when using the ‘zoom’
navigation method.

Far | 0 Close
T

Choose here the objects to display in the Navigator Panel.

[¥] pins [¥] Net Labels

[¥] Ports [¥] sheet Entries

[¥] Sheet Connectors [¥] sheet Symbols

Graphical Lines
Cross Select Zoom Options

Choose here the options used to zoom on graphical objects in Cross Select Mode,

No Zoom -

SetToDefaults |- [ Save..

] [ toades -] [ import From.. ] [ugancel] [ #om

PR




(1)*“Highlight Methods”#E75 X 5l . FH] T~ 15 ¥ 38 4o 5t I AR 3E 45 B oot R 5 TAR IX i
ENGEPIWSE TSN RO

D" Zooming” & HEHE : F ShIRHE W 1 L], e R T S fe KAk o .

@*“Selecting” 5 FEHE « i FHL T A EREY I TTRT R AL T 2 iR .

©“Masking” & VEHE : H] T3 & A Sh 50 AR By BITx GamoE ok .

@*“Connective Graph” 4 HEAE : FH 15 B [7] B 58 I8 5k 75 36 v i) T 0 0 52 1Y) ) 245 32 2 1
B PEEEIZ T H S “ Include Power Parts™ /& $EHE , 12 358 11 5 8 12 78 BE H (0 DT X 52 19
0o 248 % 4 O P AL L R T

(2)“Zoom Precision” I X 5l FH T8 B F 0 45 5570 1 AR PN 28 v 1) FE e X 2 )RR
I i B 1 B0 % T LAV L . e Far” J7 [ i sl B9 R F )N 15 ¢ Close™
J5 I Bl B 50 R H g R,

(3)“Objects To Display” 15 X $uf : F T35 & Tt AR SR 19 B TR R N7 b a4
IR 7 AR,

O“Pins” & HEAHE : T T BE P AR P2 R g F7 .

@*“Net Labels” & #EHE . FH T E S0 215 T 28 FRs

@“Ports” & HEHE : FH T AL 1A T2 75 fob s P90 286 i 1

@“Sheet Entries” & YEHE : FH T & 16 2 2 K405 rb, 00 1 Al 9 2 75 2 7R LT
i 1T,
©*“Sheet Connectors” & YEHE : I T B 75 2 )2 R AR et b, 0T AR N 2 45 i 7R BT
e Ju

©*“Sheet Symbols” % e : T & 75 £ 2 B 40, S 00 A 9 2 75 s DU
PRk

@"Graphical Lines” 4 #HE : H T35 & AU R T2 5 BoR A BA AR L EIZL,

(4)“Cross Select Zoom Options” 3B X 35, . F T 1% B AE A kBT, 45 i B S X 4
LI,

D*“No Zoom” I : AN it -G K42

@*Zoom to Last Selected”#EI0 : 4FE] b —PMIEEEREGEXT 4.

@*“Zoom to All Selected” I : 4 jikt | Fir A W 4E (1 BUR X A

6. “Design Insight” 3£ 51 F
“Design Insight”$EI-RANE] 1-24 fros, F8 T IRCE R R DI6E, Hr iy & S5
Hur,
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o 2

Il [ ctoua preferences -
|| | a B System

| & General @ System — Design Insight

' 1) View

il &3] Account Management Dessan Resaht

Tr
g Transparency Define here which feature of Design Insight you would like to enable.

&3 Navigation
[Enable Document Insight
] Designtnsight || eekleRocument nzight
Document Insight displays a preview of the documents from both the Projects Panel and the Documents Bar, Hover over
I i Projects Panel the document icon in either location to see the preview, Click on the preview to open that document,
i3 Default Locations Enable Project Insight
ﬁ File Types Project Insight provides a table of dacument previews for easy navigation. Hover over the Project icon in the Projects

] New Document Defaults Panel ta gain insight into the documents in the project. Navigate to a document by clicking on it in the preview.

5] Desktop Layouts
i3] Printer Settings

[#] Enable Connectivity Insight

Connectivity Insight shows the connective relationship of the net abjects. The Insight will show previews of the child
sheets for sheet symbols, previews of the net connectivity across the whole project for electrical objects, and previews of

il &3 Installation the sub-parts for companents, The previews will be organized according to the project hierarchy. Clicking on the file
' ﬁ Alti Vault names in the document tree will open that document. Further customization is available in the options below,

jum Vaul
il &) Product Improvement [7] Enable Supply Chain Insight

Supply Chain Insight displays supply chain i that contain part choices. Both
pricing and availablility can be examined, Tt also nnssmie to add and remave manufactured part choices by dicking on the
Edit link.

I3 Network Activity
» [ Data Management

b B3 Schematic [#] Enable Hyperlink Insight
b [ FPGA Hyperlink Insight displays a link over hyperiink objects and over annotations and parameters that have a URL or website
fl as their text string, Use the View > Open internet links in external browser preference to determine whether websites
I & [ PCB Editor should be opened in DXP or externally,
1+ [ Text Editors
! Mouse Hover Delay: | "]
1 [ Seripting System
| Os 4s
© [ CAM Editor
I | & & smulation Connectivily Insight Options
| v B3 Wave Insight Content to Show I Launch Style
I | b &2 orettsman |Mouse Hover | Alt=Double Click
I Document Tree O
! Document Preview [
Obiject Hints
il Hyperlink v

1-24

I

(1)“Enable Document Insight”4Z 4 . F T35 Y bR T8 5T Bop 24T 507 1 1Y SCRY 1]
P b2 i AT T AR R SCRS A S s SRS B L

(2)“Enable Project Insight”4Z #HE . H] T3 & Y bR 8 FF B AF TR H BRI 5 5
PET AR IR L T

(3)“Enable Connectivity Insight” & &HE . ] T % B 2
7o PRI B @éﬁﬁ%?ﬁﬁﬂ/ﬂ CERRW O
B . TS AR H Z R A
PEIUA] DL — D

(4)“Enable Supply Chain Insight” % JEHE : F] T35 B AR HE SR o2 5 s il FR 1k
PR LR A A R B A 2, AT LS A i I AT F P o 3 AT DA o B o G L 422 0 I ) i
EAE

(5)“Enable Hyperlink Insight” % $EHE . H] T35 B @ BE4EE 8 2 75 os MR 4 R
A Ptk 35 0 i Ry HESCAR AT R T R SR B 4 . BT View” , TE SR 00 Va5 15 18
FRFT B HR BE S L DA S5 0 LA DXP sl e AR T G . Horfr, “Mouse Hover Delay”
FR AR TR BT BT RE IR 1R

“Design Insight”j

T A7 0 45 0 B T 42 56 AR 4R
AT AR 10 285 32 4 LA S LA A T
AL, By SO S P B SCHE 44 R AT IR 2308 T Y



7. “Projects Panel”

“Projects Panel”j

wmr,

SETE
PRI A& 1-25 frzs, H 71 B “Project” TH A 1Y J&

retrences |
| -

A TR IV T fiE

‘ Cloud Preferences

a [ System
&3 General
i View
3 Account Management
&3 Transparency
%3] Navigation *
&3 Design Insight

[ Default Locations
&3 File Types
] Mew Document Defaults
) Desktop Layouts
&3 Printer Settings
&3] Installation
) Altium Vault
%3 Product Improvement
&3] Network Activity

1 [ Data Management

B3 Schematic

o [ FPGA

» £ PCB Editor

» B3 Text Editors

1 3 Seripting System

1 [ CAM Editor

b 3 simulation

p B3 Wave

1 1 Draftsman

| 3 Projects Panel

@ System — Projects Panel

General

Show open/ modified status

Show VCS status

[ show document position in project
Show full path information in hint

[¥] show Grid
File View

Show Project Structure

Show Document Structure

Structure View
Show Documents
Show Sheet Symbols

Show Nexus Components
Default Expansion

@ Fully contracted

) Expanded one level

@ Source files expanded

@ Fully expanded

Sorting

@ Project order

) Alphabetically

() Open/ modified status

) VCS Status

Ascending
Grouping

) Do not group

@) By dass

@ By document type
Single Click

0 Does nathing

@ Activates open documents / objects

0 Opens and shows documents / objed

1-25

(1)*General " VeI X J5 : JH T35 B Projects” [ Az H )38 HJ& 1 » e b gk 1 4 B

FINOIL sl o

“Projects Panel” £ I+

mr,
D*Show open/modified status” 4 HEAE : FH T-i% B 7R H 45 FLAF 1H A b2 5 oR ikt

PR R ORAF BT AIRAS . ST BRRE S B3R AE B BRINE RS HPIRES

@*“Show VCS status” 4 FEHE : H] T 15 & AT H 4 HE AR 27 WoR B h SOR A 1
il RGEIRAS

®*“Show document position in project” & YEHE : F T B LT H &Mtk 275 BN
SCRERYLE

@*“Show full path information in hint” & EHE : T8 XY BUARTEE48 300 B A BRES |
BB STRG IR, PEAR 7R 15 A 2 15 s SCRY ) S8 AR

©“Show Grid”4Z HAE : T B & 7E 0 H A& FRAF AR 275 B .

(2)*“Sorting” BET X 35§ : FH F 1% & “ Projects” [l A H A9 HE 7 J& M, H A e 11 1 2 AR Dy g
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wmr.

D“Project order” 44 « FH T 150 E A2 755 FRAS I A4 516 J5 - HE 3 o SRS

@* Alphabetically” S48l - F T 150 8 2 75 4 7 BRIUF-HEFN 5 H Ay SCRy

@*Open/modified status” Py Hl . H T B & B % B O AT IE7E n 8 DL SR AT I
855 SCHESN T E A SRS

@*“VCS Status” REFHE « FH T35 B A A P RS HES 3500 5 b i 308y

Mk bk 4 PRIz — 5 . R Ascending” 5 BEHE L T H H A4 SCRE K e TH
HES 5 75 0] R Y HES o

(3)“File View”#I [X 45k : H] 715 & “Projects” A 7 Y SCIRL 1] g e He rp gk 3o i BL A
DIReanr .

D*“Show Project Structure” HEHE . T B AW H A& AR AR Th =75 Bon3i H 4544 .

@*Show Document Structure” HEAE : H T8 B 78 ST H 2 75 o SCH5H .

(4)*Grouping” VEI X 4al : FH T+ & 501 H rf & SCRY Y 43 2B 2, Herb & 2 30 i B A Ty fig
wmr,

@D“Do not group” 4% - A1 T HOH I H By SO 3 A5 T RE

@By class” Lk He4  FH 15 8 4 BRS04 BRI H 19 SCRY 4, B 25 b 1 H SORY KB
SCRYRINIA Ay — 28, HAB I Ry 55— 2%

®“By document type” BLEEFZEN « F 15 4% BRSO 2 047 SRS 40 248 B, BT A 149
JE PR SCRS A — 28, i 1 PCB ST I — 2%,

(5)“Structure View” I X I : F T+ & “Projects” [k 1 LA L &1 % , H i 15
BT BRANT .

@ “Show Documents” & HEAE : H] T 158 7RI H 48 HLES AR 2 75 7R SCRY 4

@*“Show Sheet Symbols” 4 FEHE : HI T 15 B AETH 45 #8275 R bR &

®“Show Nexus Components” & ¥EHE . FH T 1 B 7E 50 H A& B 25 i dz o2 76 B os 7% 8
iR

(6)“Single Click” 5 X I : I T% & “Projects” Hik o (1) F. o J& 14

D*“Does nothing” fLIEFEH « I T B AR H 48 B 28 bk b s TR DB

@ Activates open documents/objects” BLEEFZE - F T30 B 7R T00 H 45 BRES 1l H B 2
IS FT R SO o 42

©“Opens and shows documents/objects” 4l - H] T 15 & 7RI H 48 Hils 1 Al h B
SEFT I BRSO o0 42

(7)“Default Expansion” #6301 X 3k . F T-i%& & “Projects” HAR P EAY @t ,

D“Fully contracted” 4 - $5 FEBRIA A 18 B0, NS 2 .



@*“Expanded one level” g5 #H - $i2 IEBRIA R BEE . 7 e —44

@*“Source files expanded” FAYEFZEH - 34 HE BRI AL B0, 97 B Y S

@*“Fully expanded” LIEHEHH - 49 e

8. “Default Locations” & i &

“Default Locations” i+ F T 1% B8 1 SCRY A1 B4 BRINL B X BE B AR AR FT IF SO i

RN AT L5 ]

IFl

9. “File Types” &I+

“File Types” eI+ ani& 1-26 frs . T 5% & ERIAE FH Altium Designer 16 FT #3014
AR, — HH P SO AE) 36 v kv E— 3 B 44 B SO 2R A R 0 A2 S AE , ZE TR Y

FANCAHRR A Altium Designer 16 #1730 %

4

/| Deseription =

Altium AGUI Design File
ASM Source File

C Source File

C++ Source File

C/C++ Header File

ASM Source File

Altium Software Platform File

LI

Altium EDIF Document
Altium EDIF Document
Altium EDIF Document
Altium EDIF Library

Altium EDIF Document

Altium Component Library
Altium Compiled Library
Altium Library

Altium Pad Via Library

Bom Document

Altium Constraint File
Altium Database Library File
Altium Database Link File
Altium Constraint File

Design Rule Check Report
Altium NC Drill Report File
Altium Netlist File

Simulation Netlist Document
Altium Output Job File
Report File

Report File

Protel PCB Document

All On

Selected On

|
fl ‘ Cloud Preferences
4 [ System
[ 53 General @ System — File Types
l ) View
&3] Account Management Assoctated Fie Types
&3 Transparency
&l Navigation Register | Etension
&3] Design Insight B o
&) Projects Panel ¥ Agui
f & [¥ Asm
Default Locations. El c
%3 File Types ¥ cop
] New Document Defautts 2 ¥ H
BB M s
] Desktop Layouts iE ¥ sweiatform
3 Printer Settings =] ;1@ o EDIF
&5 ¥ Edt
£ Instaliation B E e
) Altium Vault 5 ¥ edr
&3 Product Improvement el ¥ Ediflib
& V] Edn
&3 Network Activity =
1 [ Data Management EE Libraries
1 [ Schematic 5 ¥ cmplib
&1 ¥ IntLio
» 3 FPGA G ¥ b
b 3 PCB Editor B ¥ pib
BE Other
1 [ Text Editors & ¥ Bonec
- £ Scripting System R ¥ Constraint
1 [ CAM Editor gl g::mk
= v inl
& [ Simulation EQE
» B3 Wave B Outputs
= ¥ Dbre
» £ Draft: 3
[ raftsman =R
¥ et
o [ hsx
¥ outiob
[El ® Rep
. ¥ ret
2@ PCB
B ¥ P
setTo Defauits |-] [ save.. |+] [ toad.. || [ import From.. |-

[

ok | [ coneel ][ et

1-26

10. “New Document Defaults” & I+

“New Document Defaults” &I -ENE 1-27 s, T E#H Altium Designer 16 3
R SCOFIRT RS RN 2 . A0S P P08 5 — R o8 SR8 B R i 2380 SO 1) 1 BRI S
1 B 28 Altium Designer 16 Hr 09 BT A5 1228 4 1) SCEF 4] 1R N 25 FwD R 58 & 405 0%

[PPSR

“File Types” &I+
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SCHFARAIE]. FP ATTENew documents default” 4% Fhise B4 R AL 4 SCHF AT BRIA LA

‘ Cloud Preferences v‘
a [ System
& General ﬁ System — New Document Defaults
& View
€3] Account Management T Tt
&) Transparency
& Navigati Document Kind | New documents default [«
Wigation B2 PCB Project |
&3 Design Insight [ Schematic
& Projects Panel ERrce
& Defautt Locations ] Draftsman Document
) 1 Schematic Library =
&3 File Types P Library
13| New Document Defaults 52 Component Library
&5 Desktop Layouts CAM Document
& PinterSet {5 Output Job File
merAslings (5 Database Lib File
| i Installation (5 Database Link File
&3 Altium Vault E] 2] FPGA Project
| Schemati
i Product Improvement M suiexatiy
£, OpenBus
3] Network Activity %) Finite State Machine
» B3 Data Management [7E] VHDL Document
b B Sthematic [F] Verilog Document
[ VHDL Testbench
v B FRGA 5] Verilog Testbench
- 3 PCB Editor Schematic Library
» B3 Text Editors vum Library
Verilog Library
» B Seripti t
b [ Suipting Systen 5 Component Library
b [ CAM Editor %, Constraint File
b [ Simulation CFile
p B3 Wave H File
[ 11 Core Project
1 EJ Draftsman [ Schematic
[F] VHDL Document |
Use this table to specify the defaults new projects and are created. Invalid filenames are grayed
For each project or document kind entry, the ‘New document default’ column indicates a default project or document.
When a new project or document of 3 given kind is created, the associated default and its settings are copied.
Schematic templates (*.schdot) can also be specified in the table, for new schematic documents.
setToetauts | [ save.. || [ toad. |-] [ importrom.. -] [Loc ][ coneel ]| sonp
| —m—— [ R — |

1-27 “New Document Defaults” & I &

11. “Desktop Layouts” &I+
“Desktop Layouts”#EI5i-K 4l 1-28 Frzw  H 1% B 5 1 bR HEA J5) S S BRI AT =)

26

(1)*“Standard layouts” eI DI - T35 B 5L 11 A AR AT J=) o
@“Apply the default layout” . JH T & 5 1 A ERINAIARHEAG R o
@*“Apply the startup layout”: J T3 51 8 Z HiJH AR o
(2)“Manage layouts”BEI X 3 . F 4 L5 [H A7 /)

D*“Load a saved layout”: T #—/~C LA H T A6 J5) .
@*“Save the current layout” : {§-7F 24 Hij ) 5 H A7 &



i | Cloud Preferences v

i a |7 System ‘
gl General @ System — Desktop Layouts

l i view

i3] Account Management Standard Layoirts

3l Transparengy

&3] Navigation

3 Design Insight

i3l Projects Panel Manage layouts

) Default Locations Load a saved layout...

i File Types Save the current layout...

Apply the default layout
Apply the startup layout

3 New Document Defaults

i3] Desktop Layouts
 lerntersettings |
' &3 Installation

i Attium Vault I

&3 Product Improvement
i3] Network Activity
‘ p [ Data Management
& I Schematic
v 3 FPGA
b [0 PCB Editor
b [ Text Editors [
» 3 Scripting System
> [ CAM Editor
b [ simulation
> B Wave
1 [ Draftsman

2t o1 uSisoq umny EEN

& 1-28 “Desktop Layouts”i& I

12. “Printer Settings” &I
“Printer Settings” &I FUNE 1-29 Fron, H T ETERVLE M,

| Cloud Preferences. -

4 [ System
il General @ System — Printer Settings
i view
3l Account Management Custom page sizes for exporting to PDF

& Transparency
& Navigation il /| width | Heignt

3 Design Insight
il Projects Panel
ll i Default Locations
i File Types
i3 New Document Defaults
i3] Desktop Layouts
%3] Printer Settings *
5 Installation
i3 Attium Vauit
3l Product Improvement
3 Network Activity
; [ Data Management
& 3 Schematic l
p B3 FPGA
b [ PCB Editor
p [ Text Editors
1 [ Seripting System
p [ cAM Editer
b [ Simulation
» B3 Wave
& [ Draftsman

[ edtpase. | [ femoe |
| SetToDefauits || | Save.. ||| Losd. |1 | importFrom. |- oK Concel | | Apoly

1-29 “Printer Settings”i%£ i F
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13. “Installation” & Ik

“Installation” I K 4N 1-30 Frs . TR E L2530 Mg k.

|
‘ Cloud Preferences

4 [ System

i3 General
& View
&3 Account Management
i3] Transparency
&3 Navigation
&5 Design Insight
i Projects Panel
i3] Default Locations
i3 File Types
&3 New Document Defaults
3] Desktop Layouts
I3 Printer Settings

[ 53 Installation.

ﬁ System — Installation
Automatic checking

Here you can specify how often application will check for new updates,

(0 Global installation service
You should be logged in Portal

() Local installation service
You should be logged in Altium Vault

@ Offline installation

% 110

I &3 Altium Vault

&3 Product Improvement

1 [ Data Management
b 3 Schematic I
v [ FPGA

v 3 PCB Editor
© 3 Text Editors
1 3 Seripting System i
» 3 CAM Editor i
v B3 Simulation |
b B3 Wave

1> £ Draftsman

| i3] Network Activity

] [Lcaneet J [ oon

l setopefouts -] [[sove.. || [(toad. -] [importFrom. |-

1-30

“Automatic checking” e X 3, . FH 1% B W FHFE 7 A5 2 BB A %%

(1)“Check frequency” NHLHI FAE : F T35 A 19 455, 4045 Never AR L On
Start-up(7E R S8 SR L Every day (B K& MDD . Every 3 days (& 3 KM | Every
week (B} JE D \Every 2 weeks(5f 2 JIKND \Every month(4§ H &Gl 7 A~ ,

(2)“Global installation service” JLuE 54 : T 22 %% TP i 2 BR 22 IR 55 1 Uk, i “ You
should be logged in Portal”4%4% , ¥ T UN& 1-31 iRy Account Sign In” (K 72 55 FEHE

r | e
Account Sign In |

: Remember

“Installation” & I &

User name |

Password Remember

| Sign me in when I start Altium Designer

Information about your PC hardware will be gathered as part of this process, This information will
pass over a secured connection, More.,,

1 have read and understand the warning

| Sign In | [ g_amﬂ ]
& 1-31 “Account Sign In”XtiE1E



(3)“Local installation service” LG H 40 . JH T 22 35 vh i AR M 22 B IR 45 56 9F . B “ You
should be logged in Altium Vault”582, T H-UNE 1-32 Fsid Altium 2 5] 2235 AR S5 B IEXTHGHE

r ==
Connecting to Altium Vault... i
Please, sign in to Altium Vault
Server address: | v
User name:
Password:

Remember the credentials
Sign me in when 1 start Altium Designer

[eon ) ()

1-32  Altium 2 7 R IR FIIE X EIE
(41 *Offline installation” BLEEFH : H T B B4 LR
14. “Altium Vault” &5+
“Altium Vault” 35K W& 1-33 fiR , T 222t iy Altium 23 6] B RRASIE o

[ ctoua reterences |

. a [I7 System I
5l General @ System — Altium Vault
g view

i3 Account Management
3 Transparengy Ee recnlialy
g Navigation
3 Design Insight
i3] Projects Panel User Name -
&3 Default Locations

File Types

3 New Document Defaults
i3] Desktop Layouts

&) Printer Settings

Server Address || %

Password
Sign in Attium Vault
Actions
B i [C] sign me in when I start Altium Designer
3 Attium Vault
i3l Product Improvement
€] Network Activity *
» 3 Data Management
o [ Schematic
b 03 FPGA
b [ PCB Editor
1 [ Text Editors
| | © E3 Scripting System
b [ cAM Editor
b [ Simulation
b 3 Wave
» [ Draftsman

seto oo |2 (e |2 [tss. |- [smpontion. |- o) o (o)

1-33  “Altium Vault” &I+

15. “Product Improvement” & IR

“Product Improvement” &I E 41K 1-34 frs, A TIX B 2SS Altium 2 5 8977 5
kTR, e Participate” S EAHE . KRS

2t o1 uSisoq umny EEN
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e

| Cloud Preferences

l 4 [ System
l i General
i View

ﬁ System — Product Improvement

i Account Pr

&) Transparengy

& Navigation

&3 Design Insight
&3] Projects Panel
i Default Locations
i File Types

) New Document Defaults
i Desktop Layouts
3 Printer Settings
i3 Instailation *

&3] Altium Vault

o Product

Would you like to participate in the Altium Product Improvement Program?

articipatel

This program helps us to improve Altium Designer through understanding customers' behavior and environments.
Anonymous information about your computer hardware and how you use our software will be sent periadically to Altium
servers for analysis, without any interruption to you.

The information that is collected Is not used to identify or contact you.

Be assured that:

+No design or IP information is collected as part of this program.

« Al informatian that is collected is anonymous.

+ No personal data is collected as part of this program,

+ You can stop participation in this program at anytime by going to Preferences > System > Product Improvement and
unchecking the Participate box,

€] Network Activity *
© [ Data Management
[ senematic
3 FPGA
B3 pcB Editor
¢ [ Text Editors
3 Scripting System
[ cAM Editor
3 Simulation
b B2 wave
¢ [ Draftsman

Read Altium's Privacy Palicy

SetToDefauits |-| | save. ||| tosd. -] | tmportFrom.. |-

oK Lancel Appl.

& 1-34

“Product Improvement” % Ij

16. “Network Activity” £ I

“Network Activity "SR UNE 1-35 7« i ot 126 b /BT 26 ke 6 3% /BT P 16 33 Fr)

TSR

| Cloud Preferences

4 [ system
il General
) View
& Account Management
i Transparengy
il Navigation
&3] Design Insight
&l Projects Panel
) Default Locations
i3 File Types
3] New Dacument Defaults
i Desktop Layouts.
il Printer Settings
3 instaitation *
& Altium Vault
&3 Product Improvement
i3] Network Activity *
¢ [ Data Management
b E1 Schematic
b B FPeA
©» B3 PCB Editor
b [ Text Editors
¢ I Scripting System
b [ CAM Editor
b B Simulation
b B Wave
© I Draftsman

ﬁ System — Network Adtivity

Metwork Activity

Altium Designer uses the Internet and third party servers to connect to Aftium Cloud, Altium Vault, suppliers, to search for
updates, etc. It may be desired or necessary to work offline in some situations or environments. On this page, you can
disable specific network activity or disable all netwark activity by selecting or deselecting the desired functions

You can select or unselect all options by checking/unchecking the Allowed Network Activities checkbox,

Uncheck to disconnect from Altium Portal. When you uncheck this box, Altium Cloud and Global Update Service
will sutomatically alse uncheck (disconnedt).

Altium Cloud

Uncheck if you da nat desire any access to Altium Cloud, This option ¢an be particularly useful when working in
classified or public WiFi environments,

] Attium Vault
Uneheck if access to Altium Vault is not required.

[¥] Buitt-In Browser
Uncheck if access to online Help/Search functions is not required,

License Server

Uncheck to stop all License Server related traffic,

Suppliers

Uncheck if you da nat require access to suppliers servers

[¥] NanoBoard Firmware

Uncheck if you do nat want to receive updates to the
Designer,

3000 Firmware that is

Global Update Service

Uncheck if you do nat want automatic checking, downloading and installation of updates from the global server.
[7] sending Crash Reports

Uncheck if you do not want to have any crash reports sent to Altium.

[¥] Publishing

Uncheck if you do not need to access the Publishing Destinations (for output jobs) that you specified in
Preferences » Data Management » Publishing Destinations.

Product Improvement

n

SetToDefaults |-| | save,. |-| | toad., -] | tmport From., |-

oK

1-35  “Network Activity” %&£ IR
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Altium Designer 16 ST H E Lscit B, A a] LURTE A C 9484 ~J 15 il 2 45
EREASE T HASFISESRAE AR ST . BT (5 U ph B+ A A8 1, BRI Y B R 8 e A
it fE“DXP. res” X . AL G418 i BRS Bar A 41 A € ORI R 7% IR IR

(18 3h Altium Designer 16, 7£ 3= 3 B p $f1“DXP”—“Customize 452, F1 I A0 A 1-36
IRy Customizing PickATask Editor” (A & SCEEHRAT: 55 S ) X THHE

r Customizing Pich__ATafEf__di‘tar d i
Categories Commands
CEEET N - | Default Bars [~
{ngipts] | |E-Atium3DModelDocument El

IltiumBinaryFileDocument
ItiumLib
tiumPCBEBlockDocument

[System Level]

Altium Documentation
Embedded
File

Help

Library

Mixed-Signal Simulation
Mavigation

Mew

Mo Document Shortcuts
Mo Document Tools
Project

Recent Documents +-

Recent Projects F- Natahazal ik =
Recent Workspaces »

Script Files il | ~ | l
I HNew... ] | Edit.. | | Duplicate | | Delete

1-36  “Customizing PickATask Editor” 3115 4E

“Customizing PickATask Editor” % iFHE 4L & “ Commands” (454 Fi1“ Toolbars” ( T E.
DO PIATEIR  Horh Commands” P35 HI T X5 2 5N (i & EA T IR B L “ Toolbars” 1K
FH T P 8 0 58 B 0 S BRUFD T HA

(2) AF “Customizing PickATask Editor” X i #E #7, 1% # “ Commands” 3 I £
“Categories” 5] R HE 1Y “New” BE I, I 5§47 “ New” % £, 4T IF @ & 1-37 7R (1 “ Edit
Command” (Gt 48 iy ) X IR HE

(3) 2o 5 “Edit Command” X 35 HE 1% “ Action” ¥ T X 38 N B “ Process” % 48 AE 45 ] %)
“Browse #2461 , 3T UNK 1-38 Frzn B “Process Browser” (BEFE N U #3) XHEHE .

(DO AE“Process Browser” S i HE A7, 15 $E“Client: HelpAbout” (% v . 85 WD a4, B
“OK" e A% 2 VRN E) “Edit Command”XFEHER Process SiEAET . 1A 1-39 7R
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Edit Comm

Action

Process:

Parameters:

Caption

Caption:

Description:

Bitmap File:

Preview:

Shortcuts

Primary:

Currently in use by:

hd Alternative: b

Currently in use by:

[

3 | 3 ||

[ ox J[ concet ||

& 1-37

“Edit Command” X} {5 HE

Client:CrossProbe
Client:CustomizeResources
Client:Favorites
Client:FullScreen

U

ClientImportSpeedsettings
Client:Licensing
Client:Navigate
Client:NewDocumentForm
Client: QuitFromEDAClient
Client:RestoreLayout
Client:RunCommeonDialog

-

Show processes

[aw

Description: Display the version number and copyright of EDA/Client

=) [

& 1-38

o 32

L—.-%—JLAJ

“Process Browser” X1 iE {E



r = = =
i command
Action
Process: Client:HelpAbout « | Browse,.,
Parameters: - Infou.
r Caption
|
|
Caption: i
Description: -
Image
Bitmap File: lE‘
Preview:
i
i Shortcuts
il Primary: - Alternative: -
L
Il Currently in use by: Currently in use by:
I ol g
| |
|
’ oK ] [ Cancel ]
e = =§!

1-39 iR /N“Client: HelpAbout” 5%

(5 7E“Edit Command” ¥ 3HHE“ Caption” (rail) T X 35§, P4 19 “ Caption” R S5 AE H i A
HEER A S I 24 FK HelpAbout, 7E“Description” G4 ) Fi SEHAE h iy A XTZ iy & B4 148 1
RS

(6)7E“Edit Command” %1% HE A9 Shortcuts” CEREESE) 137 X 38{ Y , 7 “Primary” T H7.4]
FAE h R P Corl+ H M a2 B9 PREERE  an&] 1-40 Fion . R OK ¥4 . Bt iy
“HelpAbout” (F5 B 4525 i /8 7E “ Customizing PickATask Editor” X iHHE [ “Categories”
GIZRHE Y Custom” ORI Y A7 0 LT A 4n 18] 1-41 fos .

(DK FARMEBE BRI E 1-41 Frs 4 M A4 “ Commands™ 51 & o 8 19 1y 2 HelpAbout”
AT BB 2 B TR R A B3 S B File” S SR b BRI BB 20 B, BV SE L T A
“File” St rh g i Help About” (5 Bl 3¢ i & (4 TAE, il 1-42 FoR, HPATiZm 4L
s Crrl+- H PREESE T, RGCARFE T HFHE B o T .
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Action

Process: Client:HelpAbout

Parameters:

Caption

Caption: HelpAbout

Deescription: EE

Bitmap File:

Preview:

Shortcuts

Primary: || Alternative:

| Ctri+E - ‘
Currently in u Ciri=F ly in use by:

tri+=G
o mEr——)
L CErl+1
Ctri+J
Ctri+K
Ctri+L

[ ok J[ concer |

1-40  EFFRIESE

' Customizin g PickATask Editc

Categories Commands

[Default Bars] » |Caption | Shorteut | Alternativ
Ali __ - HelpAbout Ctrl+H

[Seripts]

[System Level]

Altium Documentation
Embedded

File = |
Help

Library

Mixed-5ignal Simulation

Mavigation

New

No Document Shortcuts —
No Document Tools

Project

Recent Documents

Recent Projects

Recent Workspaces St

| New. || Edt. || pupicate |

®

B 1-41  FHZEH “HelpAbout”3E B 454

N 3



[l 0P | Fle | View Project Window Help I
DB New ' .
e E Open.. Ctrl+0 Hot =
-
Close Ctrl+F4 - 5
Bf she) B Open Project... =
L= peb Open Design Workspace... Vh 8
Bl ook ou. =3
ity TS adH | g
+
B pce 2
& Mo Save Project —
e . =)
= Ma Save Project As...
1
- Save Design Workspace g
e Save Design Workspace As... EEH
& pes) Save All
&l Lea % Smart PDF...
(4 Mo
E Mo Import Wizard 1
- Release Manager...
B pee| Recent Documents ]
= schi Recent Projects 3
£ 0pd Recent Workspaces 3
s AlteFa
Vi
= |

1-42 3 jn“HelpAbout” #5 4 F|“File” 3% g rh

S

=]

1. TR R BTSN B BT A R ) E 2R A

2. a7 58 % Altium Designer 16 #0419 45 530 .

3. G ] Altium Designer 16 B TR E 1 .

4, A 5E R Altium Designer 16 [y Preferences 01X & .

5. 7& Altium Designer 16 fJ“View” BN “Fullscreen” 454,
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VEBIHERE . 23 TE A Y 5 RE A= iV B 48 E DI RE PCB A A HE A .

— REEZITHNT R

SR E BB R AT

(D a3l Altium Designer 16 24, 6@ PCBIiH

(2)7¢ PCB I HF , B Jr 2 SO - i o) i B ] i B 2

(3) B P AR /NIRRT o 2 1l D PRI T A0 ZBUAR A S5 I s, Jf 1) 52 2 i JBE R 18 TR 4K
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Uiy 145 L SO GO B iR e ARSI b P AT DR e AR BT 1 % 420G 2R 6 HAE T
VEF-THT b A7 B R T IR B IR TR i g 5 B T e ORI, g — 20 TAEAT 4
FERilt o

(6) LA TR . A Altium Designer 16 $& It 445 T B Ay A5 TAEF-1fi LY
HL AN G R R A I — 1 5 1) i S B ]

(T D R PR A H ASCRE ARG o 22 ) S B [ i 5 223 & Project Options” 4 6 24
HIIH A8 Altium Designer 16 &4 5 AN 5 SR U A

(8)AE LA A SO ATEN S 1 o W] i 3 TR AR R 2% 3% JT PR i B35 4% bl 35, o il
WEITENSHOFHEATITEN O A BN i) i, AR IS A

— . Altium Designer 16 [RIEE&it T E#

Altium Designer 16 ()53 K5 M) 32 T HAF A Schematic Standard (3 K45
W T HAL  Wiring (%8S T 242, Utilities G D T HAZ, Hirh, Utilities T B A% 035
“Utility Tools” Gl FH 73 8) . “ Alignment Tools” GG B HEF 73 8) . “Power Sources”
CHL Y R 42t 3 ) FN“ Grids” (PR BEE T3 B4 T3, 840 A1 X 26 T H AT IR R
o7 JE R 2. R A LA EE T HA AT 5 OCH] .

1. “Schematic Standard” TE#=

“Schematic Standard” T EA2UNK 2-1 frzs . 37585 06 ] 7] 34T “ View”—“Toolbars”—
“Schematic Standard”sg .54,

| 1 m 5

a3 1R i 0 - B o O S IR
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& 2-1 “Schematic Standard” T EL#=

2. “Wiring” TE#=
“Wiring” TEAINE 2-2 A7~ FTIF 8 0C ) 0] #4147 “ View” —“Toolbars”—“ Wiring” 3¢
HATA .

_-;'h}-kg# D@ GG ® X% 2|

2-2 “Wiring” TE#
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KBS, Z T EAAE S “Utility Tools”* Alignment Tools”“Power Sources” F1“Grids” P4
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2-3  “Utilities” THE#=
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L Place GND power port
¥ Pplace VCC power port
“E  Place +12 power port
S Place +5 power port
- Place -5 power port
4 Place Arrow style power port
7 Place Wave style power port Cycle Snap Grid G
T Place Bar style power port Cycle Snap Grid (Reverse)  Shift+G
[ Toggle Visible Grid  Shift+Ctrl+G
L Place Signal Ground power port Toggle Electrical Grid Shift+E
L Place Earth power port Set Snap Grid...
(o) “Power Sources” F-3ZH (d)“Grids” F3E 5
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What's New
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WHAT'S NEW

How Ultrafast UV Lasers are Improving HDI PCB Design Layouts

GreuitScudio, May 9, 2017

Do you remember the first time you saw Star Wars? | was 12 and it changed my world forever. Id seen my future.
Instead of a car, | would fly a spaceship. Instead of being an accountant like my father, | would be a lightsaber
wielding Jedi. Sadly, | turned out to be neither a Jedi or an accountant, but a humble PCB designer. Lasers still have
a place in my life, though not in the way | thought they would. Instead of using them to blast holes in the Death
Star, | let manufacturers laser drill microvias in my high density interconnect PC8s. So | guess I'm more like the
Emperor than Luke. Advances In ultrafast UV lasers willlet manufacturers pepper my boards with smaller vias
more quickly. Shrinking vias will mean more dense PCBS with less EMI at a lower cost.

Why Version Control Should Be Implemented in Your PCB Design

Software
Alvum Designer, May &, 2017
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LOW STRESS, NATI|
FOR PROFESSIONA|

NEW TO ALTIUM DESIGNER|

There's a lot to learn to maximiz:
Altium Designer. Start your Evalt
geta head start on your next PC
Learn how to:

* Create your first schematic ar
* Prepare your PCB for manufa
* Build your personalized comy

START YOUR EVALUATION G

GET SUPPORT
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Open... Ctrl+O B PCB

Close Ctrl+F4 #f Drafsman Document -
Open Project... 2 Text Document

CAM Document

Save Design Workspace

Save Design Workspace As...

Check Qut... Output Job File

HelpAbout Ctrl+H Project..

Save Project Wikt P
Save Project As... Script Files "

Mixed-Signal Simulation »

Release Manager...

Embedded v
Save All [E1 Design Workspace

% Smart PDF.. [l FlesPanel  Cirl+N
Import Wizard
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How Ultrai

Recent Documents ]
Recent Projects 3 CircuitStudio, May 9
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Project Types: Project Templates:

PCB Project <Default> &
FPGA Project AT long bus (133 x 4.2 inches)

Core Project ATlong bus (13.3 x 4.5 inches)

Embedded Project ATlong bus (13.3 x 4.3 inches) =
Integrated Library AT long bus with break-away tab (13.3 x 4.2 inches)
Script Project ATlong bus with break-away tab [13.3 x 4.5 inches]

AT long bus with break-away tab [13.3 x 4.8 inches)
AT shart bus (7 x4.2 inches)

AT short bus (7 x4.5 inches)

AT short bus (7 x4.8 inches]

AT short bus with break-away tab (7 x 4.2 inches)
AT shart bus with break-away tab [ 7 x 4.5 inches)
AT shart bus with break-away tab {7 x 4.8 inches]
Eurocard VME 3U (3.937 x 6.299 inches)

Eurocard VME 3U (3.937 x 8 660 inches)

Eurocard VME 3U with break-away tab 3.937 x6.209 ... ™
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1252 |
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PREVIEW NOT AVAILABLE

C\Users\Administrator\Desktop
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Repository
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| | | Browse Folder.. ‘ [l Managed Project
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Open... crlt0 @@ PCB
Close Crrl+F4 BOM Document
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fE55 — P 4t i &

Jir R s e B 5 10 PRI AR AE 465 (R AR 8 RS O M) L 0 A A
SN OB SR L R P O A
TR R S T 47 Design”—“Document Options” 32 Bay4, FTIFANE 2-13 Fr
7R “Document Options” (CRYIEI) X F5AE » AT PAFEX X TEHE th HEAT I ARSEU I E
AR AEREEABFHIRE T, & B4 D AER A& &, 16 Pedt KR F BT
“Options”“Document Options” %4>, & 7T YL 3T FF4e B 2-13 Bf 7 45 “Document Options” 2F

TR G X A

TEAE,

e - oy %
| |/ Sheet Options il | units | plate|
| Options Grids Standard Style
Orientation Landscape - [¥] snap 10 Standard styles IM ']
Shieet Numbex Spaces [ Electrical Grid Custom Style
[¥] Show Reference Zones Enable Use Custom style
t .
[_Ddault'. Alpha Top to Botton 7_] Grid Range 4 Custom Width |1500 \
[¥] show Border Custom Height ~ |950 ‘
Show Template Graphics -
X Region Count |'J ‘
UniqueId = ¥ Region Count |-l ‘
DRYFGRXA Reset. —.CI..'N".'= System Font
Margin Width |2'J ‘
e From
Sheet Color
Link To Vault
. ”
& 2-13  “Document Options” % 1E &

1. “Sheet Options” £ F

1) “Standard Style” %I [X 15,

4R RN AT LUFE Standard Styles” 7625 DX sl Hh 7 45, B ml DL £b v ) R RE RO, i
A DR AR 0 R G O AT B EIARR RN

FH e I B0 2 s o PR S RT3 7 ] s o PRI AR RS 8 W T . 5 0 2 < T
“Standard Style” T 51 FAE r , MR B i 00 L B St A 199 DR /N e 6 FH AR vE LR 5
SRJE B OK ™AL R AT
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A4 11. 69X8. 27 orcad A 9.90X7.90

A3 16. 54X 11. 69 orcad B 15. 409, 90
i A2 23.39X16. 54 Orcad EFRE orcad C 20. 60X 15. 60

Al 33.07X23. 39 orcad D 32.60<20. 60

A0 46. 80X33. 07 orcad E 42.80X32. 80

A 11. 00X8. 50 Letter 11. 00X8. 50

B 17.00X11. 00 HiAt Legal 14. 00X8. 50
et C 22.00X17.00 Tabloid 17.00X11. 00

D 34.00X22. 00

T LAY B JE mil, 1 in= 1 000 mil = 25.4 mm
E 44. 00X 34. 00

2)“Custom Style” I [X 15}
R RS A CRRRRZEK 1T LA E JEARE I E AR RN, 7E “Custom Style” HE 30 X 3,
FP RS A O A RRIR B, 7T DA JE AR ME R A 8 LR R . B 5k i “ Use Custom

style” G EHE , LAV A L EIARTIRE, Al 2-14 PR, AT N4 DI REQn T o
(1)“Custom Width”: 5 % [EI1 4% 56 i
(2)“Custom Height” . % B K405 B,
(3)“X Region Count” . % & KL X 1S5 A bR o045 .
(4)*Y Region Count” . BB K4 Y 515 % bR 3 4 .
(5)“Margin Width”; % & F 450 HE 56 FF
(6)“Update From Standard” : ¥ H1 BOFRHE R 485 ) R L2 A 8 CRSTR

Standard Style

Custom Style

Use Custom style

Custom Width 950

Custom Height 750

¥ Region Count 4

¥ Region Count 4

Margin Width 20

Update From Standard
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3)“Options” 317 [X 5k

£ Options” FeI DI, AT AT LU 14807 ) a2 | R A HESF HEA T I

(1) *“Orientation” | 731 FHE . 5 B E 487 1), i E 2-15 ffizn . 78 Orientation” | $i7.51]
FHE AT A 1ET  RI Landscape” 3278 K HUEL , “ Portrait” 2 7n 7 HHE

Options

[#Title Block Portrait I
& 2-15 “Orientation” 1% &

(2)“Title Block” e . Fl Thn I~ 2B i 508 . 106 FP i S e L £ 4K L /s il
o RGHRME 2 DAY BRI , “ Standard (UL PR MERIAR RS, AN E] 2-16 Fizs, “ANSI”
23 1 [ bR D S AR, B 2-17 Fi7R . ARk Pz SR AE , RN s bn AR

Title

Size Number Revision
A

Date: 2017-05-08 [ Sheet of

File: C:\Users\..\Sheetl.Schpoc \ Drawn By:

& 2-16 “Standard”#RE 42

Size FCSM No. DWG No. Rev

Scale ‘ ‘ Sheet

2-17 “ANSI”#RE42

(3)“Show Reference Zones” & HEHE : H] T B 27 o FIAGHHER) R 5] X,

“Default: Alpha Top to Botton, Numeric Left to Right”: BRI\, M T 21 i 5 11 F F
ALB,CoeFon s WA IR TT 10 T 1.2,3, 0w
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JEEN T 1 178 ALBLCy -3 s WA B )7 [ R 1,2,3, 380K,

(4)“Show Border” % VEAE : H] T &2 75 /s I 4RI AE
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FHIAL

4)“Grids” B0 X 5
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BRE -
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(2)“Visible” 52 VEAE : H] T3¢ & rT RS B9 RUSE . AT LA B B 3 H s TR |52
PR 7 RIS A SRS NSRRI RS 3

5)“Electrical Grid” & [X 15,

A “Electrical Grid”#63 [X 18], H“ Enable” 22 18] i) & 6 AE , W R Ge 78 1% 22 20 1 LUy
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6)“Change System Font” 4l

Hiid; “Change System Font”4%#l . 4TIF W&l 2-18 s 09« AR XA HE , T 7 AT LAFE I
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2. “Parameters” &Il &
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AR GBI AFRFIE ., i Add” Edit” 83 “ Add as Rule” ¥4 #04 B7 an &l 2-20 firs
[)“Parameter Properties” X[ 4GAHE , 1] LAE AR a4 T 350 L IR i 285 4 0720 i R 454

! Shutﬂ,plmni Units | Template
! Name / |\|'ilue \Tvp: -
| CurrentTime * STRING
Date % STRING
DocumentFullPathAndName -, STRING
DocumentName ol STRING
DocumentNumber ol STRING
Engineer * STRING
ImagePath i STRING
ModifiedDate L& STRING
Organization . STRING
ProjectName -, STRING
Revision d STRING =
Rule Undefined Rule STRING
SheetNumber x STRING
SheetTotal . STRING
Time i STRING
Title * STRING e
(oot ] [ remore.. | (LBt ] [AddasBuie.]
[Z] Link To Vault
o)) |
)

& 2-19 “Parameters” £ IR

Peonepopies

Name Value
[
Visible Lock Visible Lock

l Properties

Location X 358 Cuiu!- Type

Location ¥ 260— Font Times MNew Roman, 10
Locked Unique D ESRXLIRV i
‘ Orientation M Allow Synchranization With Database [7]
[¥] Autopasition Allow Synchronization With Library IE

' Justification [Bettom = | [Leit -

2-20 “Parameter Properties” X1iE1E
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£ Altium Designer 16 RGE . A JUIFE AT IO SR BT Fh 2 ] R it D E PR 1
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G L AN IE] 2-21 FroR B OCPFE AR AR 455 T REBE A AN 2-21 i

HHoTIE
[ Libraries v x|
TN BN e A B — i wibraries... [ search.. | [ Place 2N3904 ) T e
& Miscellaneous Devices.IntLib ﬁi"\‘ E%\Q\DHEU ﬂ:ll ﬁﬁ}r‘tiﬁ:iﬁ FP E"Jﬁﬁ%ﬁigé
. BCE T R TR I SRR AE
Compo... / |Library | Description | Footprint | »

ﬁ 2N390: Miscellanec NPN General Purpose ATO-92A
ﬂ 2N390¢ Miscellanec PNP General Purpose A TO-92A

{EADC8 Miscellanec Generic 8-Bit A/D Convi SOT403-1_b T—I:#%_Eﬁ'lﬁ
4 F Antent Miscellanec Generic Antenna PINL
ﬁ Batter) Mlscellane( Mum(ell Banery BAT-2
ito hrieal. Dina
195 (omponents
~
?
2N3904 JR TR R T At i SR P P A R
Model Name | Model Type | Source 7 &
[ & 2N3904 Signal Integrity
%) 2N3904 Simulation 2N3904.mdl Bk e A AR S B
£ 10924 Footprint Miscellaneous Device|

JEIRBTE ST PCB AR ‘

Supplier

Description unit|*
Price’

, |Manufacturer

B 2-21 JTHEERAE &S TR

Z TCHERIE

A 2-21 F g« Libraries” 341 , 8% B AZE AT “Design”—“ Add/Remove Library”3Z #.
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Project Libraries | Path | Type

& Miscellaneous DevicesIntLib C\Users\Public\Documents\Altium\AD16\Library\Misc Integrated

Move Up | |Move Down

[ 2-22 “Available Libraries” %11 HE

(1)*Project” B « /R -5 {00 HAHCEK A ICIFE . A8 b 51l “ Add Library”
TR BT () 2SR/ TR RS N R, A 2-23 B . ARG P A BRIA 45 O Altium
Designer 16 2% H 5 T 89" Library” 300 . 78" Library” S Je b I BN 25 10 T
JUPE R EE L% P AT L AR e 3 A O AR 22 Y U3 SR B “ 4TI 73 4 ol il LA
JUPFEAS IR S/ TR T

=i eig R
s T= = EMEs
. s J Altera 2017-04-25 14:02
L SRR L BSDL 2017-04-25 14:03
% OneDrive | Devicelmages 2017-04-25 14:03
)\ EDIF 2017-04-25 14:02
o=\ L FPGA 2017-04-25 14:03  Szis=

HE . Lattice 2017-04-25 14:.02

B Adiristrater ). OpenBus 2017-04-25 1403 7=
I, L 4 PCB3D 2017-04-25 14:07  3rid=e
G FIs | Simulation 2017-04-25 14:03  3ofds=

J vHDL 2017-04-25 14:02  Iritss
| vhdl_lib 2017-04-25 14:03  3zétzs

Bt ANAT NA AL AN il

0 =amEE
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& 2-23  “Library” 32 {3
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(2)“Installed” YEI - : 7R Y R{IT KI5 O A LB TR . AT B AL LR h
AT ZEAR AT LA R B35 P A AR 00T H BT A L &l 2-24 Fos

D*Move Up”“Move Down” 54l : i] MBSk s B ICF A R BN 3% AU AR
TOHF A PR P Y SR U

@QTEFN it T A IO ) S Bk “ Remove " #5041 w] LK IZ o014 122 I\ 25 15 HF & R 58
FRER.

OB ZEASIN— BT W a] LA Install”$% 8 A6 3T T B 0 1F 28 XA HE o 548
REUIN B TC RGBS IO L JETT PR PR I B Y i IF A 3R

r - T
Available Libraries s ' w
| Project | Installed |Search Path|
Installed Libraries | Activated | Path | Type
c,aﬁ;ﬁﬁrclune EI Altera‘Altera Cyclone ILIntLib Integrated
Library Path Relative To: C:\Users\Public\Documents\Altium\AD16\Library\
| Movelp | |MaoveDawn [jnnan... |v] | Edit [ Remove ]

2-24 “Available Libraries” X115 E

(3)“Search Path” I . 8 - AR LI,
= EXTH

FH P AT AAE Je 0 PR A8 Bl s vh A R OeF. 7R I8 2-21 Foos By ook PR Bl gs b, s
“Search”# 4, Z G ¥ WK 2-25 F1 s [ “Libraries Search” 3fiEHE., 47 “ Tools” —
“Find Component” 3¢ B 2 AT FT I Z XS THHE . FEXTTEHE H , 7] LABOE A $ 5 S A $070
Rl ] A R G A & 7E S « . IntLib” S e fF . O IEHE A ERAE i R .

(D) “Filters” Pe Il [X 3 . JH] T80 & A R T A 7 e 4 A

(2)*“Scope” I X 3. H T B AR, 24k “Available libraries” P EF41HT
IMTEC 2 Y TTiF b A 4k, IR TR Path $RARME th b B RIEMBRAR . ik rh“Libraries
on path” AR HI I, WIFEHS & 1Y H g rh g A 4.
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